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TOUCHANCE MultiCharts Plug-in 3P|

MultiCharts =' % ﬁ,’ ﬁ]zii?f"? ’Ifj,ﬁ“@ﬁ%‘ﬂ =+ Ew ,ﬁ'_i%ﬁfj IR i F:j— P LH[QEU-;S, ! li (-, x;JF: figed

A f [Fi SR 2P T 58 5y 40 =9 S b - Pl 9t iy TSSupport B 58 5 5 % ph (P = |1
L ph Py R ?Zﬁjﬁﬁaiji

TOUCHANCE [ 4% ~" ¥ £ MultiCharts 5.5 I') FAY[IEs 4 pb Plug-in » & MultiCharts

FO R T TOUCHANCE [l 5 5 b B S gk 5t 0o 2R = e plo e 0 22 f1 s 2 )

FUFTZF, °

Jpif 2V MultiCharts 35|

MultiCharts $f# »" B 4% 30 U a] - & I} % 3 MultiCharts Py A Jfﬁll%tﬂK iy o
ThOER A B

1. 35 2] MultiCharts Fiff © http://www.tssupport.com

2. E]tfﬂj “Support” # & “Download & Check Version”

TRADING SOFTWARE
& individualized support

MultiCharts ; Other Products & Service : Support : Company

3. %ﬁfﬂiﬁh* gpuyy 4 > B “Download now”
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Downloads and Check Version

This page contains information on currently available versions of products and links for downloading them. As a rul
discussion forum. Beside that, some of our product have an integrated version checking. If despite that you have di

Product Type Version Release Date Download File Size
Dfficial Release 5.5.2723.400 10 September 2009 48.4 MB
MultiCharts
Beta Version n/a

AR
TSSupportg "’* By pY Ig_\,ir;; \grff"pw E-Mail »

E hitkp: ffwan, kssupport. comysup porkfdownloads fmulticharts, shkml

MultiCharts Downiocads

Once you fill out the form below, you will receive the complete information on downloading and installing MultiCharts via
e-mail.

Before downloading please make sure your computer meets system reguirements, If you want to receive real-time data,
you should be subscribed to a real-time data service from a compatible data vendor. If you do not subscribe to a real-
time data service, you can still use MultiCharts with Free Quotes or ASCII data.

i Bk

hours, the reason may be that your request S|mp|y did not get through to us. In such a case please send your request
directly to support@tssupport.com. If you use a gmail account to sign up for MultiCharts, please check your SPAM filter,
because e-mails from our server will be filtered out by gmail ~ anti-SPAM system, You will also need to add tssupport.com
to your trusted addresses,

& s da - E100% -

5. ™ “Submit”
i FV B g

;‘FTL[VTJVT E&';Lg_n\ﬁ:l i =

MultiCharts  Inbox | %
e se—— show details Sep 21| $y Reply | ¥

Warning s message may not be from whom it claims to be. Beware of following any links in it or of providing the sender with any personal

information.

Dear Sir/Madam,

MultiCharts can be downloaded here:
http:/tssupport.com/support/downloads/multicharts. 5.5 exe

Download the installation file to your PC, launch it, and follow the instructions appearing on your monitor in order to complete the installation.

For further instructions on using MultiCharts use help file from the Help menu and review our online tutorials http:/fwww tssupport.com/multicharts/tutorials/.
Additional information is also available at the MultiCharts homepage http-//www tssupport com/multicharts/. If you still have any questions, we're ready to aid you
immediately - just contact us at http://tssupport.com/support/contacts/.

With kind regards,
Your TS Support Team
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F° &k MultiCharts

1. Fﬁ&fﬁ [ #i s MultiCharts 9 4 1

2. AL g{ﬁ{;}{”Next”

fis MultiCharts - Setup Wizard

Welcome to the MultiCharts Setup Wizard

The Setup Wizard will install MultiCharts on wour
computer, Click Mext o continue or Cancel ko exit the
Setup Wizard,

[ et I Canicel
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[ #%ﬁj i fF‘ ) ﬁﬁ;if_"_”l accept the terms in the License Agreement” »
# "Next"7& 5 b 4t -

fis MultiCharts - Setup Wizard

End-User License Agreement / L =
- MultiCharts
Plzase read the Following license agreement carefully bl/

MULTICHARTS SOFTWARE END-USER LICENSE AGREEMENT [ad

This  MultiCharts  software  end-user license  agreement
"Agreement”) is a legal agreement between TS Support Plus, LLC
("Company") and any person or single entity ("User") installing the
Company's MultiCharts software ("Software") and/or
purchasing/subscribing to any of the available MultiCharts licenses.

BY CHECKING THE “I ACCEPT THE TERMS IN THE LICENSE
AGREEMENT” BOX AND BY CLICKING THE “NEXT” BUTTON
OR BY ACCESSING INSTALLING OR OTHERWISE USING ANY P

[w]1 accept the kerms in the License Agreement

Back. ” Texk I I Cancel

4. MultiCharts 4§ ¢ /i ;JFJ' ’ ﬁﬁﬁ”’Next”%’\gﬁ@%’%{ o

i'e!;I' MultiCharts - Setup Wizard —= x
What's new in MultiCharts =) P
miditicharts
Please read what™ s new in this release of MultiCharts b r

MultiCharts 5.5 Release &

FEATURES

Charting

«  Data Window has heen added. Data Window will show price walues,
indicator values, and strategy-generated orders for a selected bar (and
the respectwe harsin other suhcharts) Thewindow can be snappedto [,

PRRTTE LN SRS U

I Back “ Mext I Cancel
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5. ZEE A EIS SR EFFY HE Z ] A4+ TOUCHANCE MultiCharts
SRR F
Plug-in pv i 4 -

{i MultiCharts - Setup Wizard - E
Destination Folder /_,- =) i
i . i . MultiCharts
Click Mext ko install ta this Folder or click Change to choose another, b_ "

_,JI Install MulkiCharts bo:

|C:'|,Program Files\TS SuppartiMultiCharts)

Back. ” Texk ] I Cancel

6. H b ATEERE ﬁﬁ}i&‘”lnstall”ﬁgﬁ@%’%& °

i'e!;I' MultiCharts - Setup Wizard —= E
Install MultiCharts 5.5.2723.400 /, ) 5
The Setup ‘Wizard is ready to beqgin the Complete installation w_"lcrlﬂm

Click Install ko begin the installation, If wou wank to review or change any of your
installation settings, click Eack. Click Cancel to exit the wizard,

Select the desired Deskbop customization settings below;
Add the MulkiCharts shartcuts to my Desktop

Add the MultiCharts shortcuts to my Quick Launch Bar

Back “ Install J I Cancel
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7. Y EES .

i‘é’l HultiCharts - Setup Wizard e :E
Installing MultiCharts 5.5.2723.400 ﬁﬂtiﬁﬂaﬂs‘

Please wait while the Setup Wizard installs MultiCharts, This may take several
minukes,

Skatus:

EESESESEEEESEEESEEEEEEEEEEEEEE ]

8. YLLK H o M Finish” o

{% MultiCharts - Setup Wizard -0

Completed the MultiCharts 5.5.2723.400
Setup Wizard

Click the Finish button ko exit the Setup Wizard,

Mditichas
- 4
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45 TOUCHANCE MultiCharts Plug-in

1. £/~ "TOUCHANCE_MCPIlugin20091201.exe |-
2. PHEEFHA %’7 He- it [ }[fj’ Plug-in % 2 %] MultiCharts U SE & T fL |
g3 5

It X

\i) S AT ST MUChan 01

I

B H TOUCHANCE 5

Bl e EE TOUCHANCE 2/a0aEh -

e AR PRAPAR TR AR = 0 LI
RS e -

i [T—&F] #8iE3E © Sile (HUH] R =iEEs -
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4. F EUF MultiCharts & 5EHS T [l o F ok ﬁ%iﬁj ST 1 R S R
oo g T - W R A

5t TOUCHANCE MCPlugin S35 50 == E

BiFAMEHE®
BIERAER TS TOUCHANCE_MCFlugin AHTE -

.__} SRS IR TOUCHANCE MCPliin So45%)| F IR E I -

1% [REFE] 4548  INRITIEIEEE—WErET » 3% [BIFF] -
CiProgram Files\TS SUPPOR TiMultiCharts BEER)..

BA-EE 08 ME RifEIsRs -

[« t—#®8 | T—2w-] [ HE |

5. [ 1) F1 R T 5 TOUCHANCE | o Flgk o 5 T = 4 ) 3l
};,r{ o

5 ToUCHANCE T35 5%

R AMEHK
RIS 4EiR 7308 TOCHANCE BOE -

| FEEESEER TOUCHANCE 4R FRATAHI -

1% (RETE] 4548 AR ITAERIE A — et - Sk (3] -
CiProgram Files\TOTCHANCE BER.

BAEE 200 MB BETER -

<= E—iE) | T = Hiif

10
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6. N TR ERE T - A

{5 TOUCHANCE_MCPigin Fe8E2 5%

BiFAMEHE®
BIERAER TS TOUCHANCE_MCFlugin AHTE -

| TSR TOUCHANCE MCPingin 43 FEATEHIE -

FFEIEE C:\Program FileshTS SUPPORT\MuliCharts B §ETFE -
g T B IS R g

T T

BA-EE 08 ME RifEIsRs -

[« t—#®8 | T—2w-] [ HE |

7O TN s

{5t TOUCHANCE_MCPlugin Z28E45 5%

.o
FAETE T ERRNAEE TOUCHANCE_MCFlugn BIEHTEEED -

BT iR iR ) 3 (5] EFRRSREESERAE -

BEyE T
Ci\Program Filesh TR STPPOR TiMultiChets

=T o

11
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{5 TOUCHANCE_MCPlugin ZraE12 7, e

A TEhK

fé&%ﬁiﬁ EHEH TOUCHANCE_MCPlugin I RIS

2 FERl] LUE R EaiEs -

12
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F%"“%—_’ TOUCHANCE EJ[JE\JJE%@‘:E[J Quote Manager

1. "Fﬁiﬁh " TOUCHANCE = #Ad =t o

2. # i MultiCharts £ [ A[J |5 # ft v % 2 > "Quote Manager” -

= QuoteManager -
File Yiew Edit Symbol Tools Help
B-EE B-E- Baemd
Filter x| Symbol «  Descripkion Exchange Listed  Cakegory Data Source Collect RT Data wjo Plotking # |
= All Symbols (443 |[6E #F Eura Futures - Globex CME Fukures &Signal OFf |
|61 #F Japanese Futures - Globex CME Futures eSignal Off
65 #F Swiss Franc Futures - Globex CME Futures eSignal Off
AB #F Russell 2000 E-mini Fukures - ... CME Futures eSignal Off
AMD ADVAMCED MICRO DEVICES INC MYSE Shocks Free Quotes Off
BO #F Soybean Oil Futures CBT Futures eSignal Off
C #F Corn Futures BT Futures esignal Off
L #F Crude Oil {Light) Futures MYME Futures esignal Off
C5C0 CISCO SYSTEMS NASD Stocks Free Quates Off
CT #F Cotton#Z Futures CEC Futures esignal Off
: ES #F SiP 500 E-mini Futures - Globex  CME Futures esignal OFf
HYSE (1) FC #F Feeder Cattle Futures ME Futures edignal Off
G #F Gold Futures COMY Futures edignal OFf
G00G GOOGLE TNC MASD Stocks Free Quotes OFf
HO #F Heating ©il Futures MYME Futures eSignal Off
HU #F Gasoline (Unleaded) Futures MYME Futures eSignal Off
INTC INTEL CORP MASD Stocks Free Quotes OFf
1 HE Twanna Toaica Fikovac i =l Fukivac aSinnal IFF = \ i
|l ! (2]
Ewent Log X
Date Time Data Source Ewent
£ >

3. Y- VH f?ﬁ«?ﬁju’]ﬁié'?,i TOUCHANCE MultiCharts Plug-in }L'% PR o

ﬁ)ﬁ?ﬁjﬁ:ﬁﬁﬂ ¥ E#"Tools”>"Data Sources” » % Available Data Sources 7|
S f[lﬁ} ¥ "TOUCHANCE"fY Status ﬂ?\[ £ "Active” o

Data Sources

#wailable Data Sources

X

Marme Abbr  Skatus  Version Wendor Cettified  File nama ad
IMetastock, M5 Active  1.0,2723,400 TS Suppart tsMSDataFeed.dl
Open E Cry QEC  Active 1.0,2723.400 T3 Support tsOECDataFeed.c
Patsystems Ps Ackive  2.0,2723,400 TS Suppart tsPSDataFeed. dll =
Feed GF Active  1.0.2723.400 TS Suppart tsOFDataFeed.dl
[ H Y L oL Lo 4 Elulut T L 9 e o P Y ) .|

I TOUCHANCE TC Active  1.0,0.6 TOUCHANCE TOUCHANCE Quok I Clone. ..
TETOTE T o = 1 s T e o el et it
TradeStation T3 Active  1.0.2723.400 TS Support tsTSDataFesd. dil Settings. ..
Trading Technologies TT Active  2.0.2723.400 T3 Support tsTTDataFeed.dl [,

%] £
Description | Connections

TOUCHANCE

13
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4. Frigr— (# TOUCHANCEEJ[JE%I‘%E o

(1) BT 2 5”Symbol”>”Add Symbol”->"Manually” -

(= QuoteManager

File Wiew Edit Symbol Tools Help
E& o El L_d Edit Symhbal. .. el (B & ]

I Add Swmbol » Manually. .. Ins I
Delete Symbal From Daka Source 4
Filker * | | Symbol = Descriokic

(2) ¥° Add Symbol # E-IHIP%@?FEEF% Symbol g% 74 » s RY & "OK” -

Add Symbol

[Daka Source: |TOUCH.C'.NCE L |
Symbal: |ICE.CME.ELRO_F.200912 |
Cateqgary: | Indexes hd |
Exchange: |§CME HE"S |

[ QK ] [ Cancel ]

® Data Source:ﬁ i % TOUCHANCE

® Symbol : 5 #* TOUCHANCE % = % ff i 3 Hl fjl iy fif 1 52V 0 & » Rl b

-
‘-—

et EEE RSO DETRE 5 TRaR)

® Category : ﬁ%ﬂ?‘*ﬁﬂ il B BT Indexes ¢

45[.; ag
® Exchange : ﬁ% Fi SI%,J& o

14
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(3) @t Symbol £ A1 i -
® Indexes & Settings : ﬁ% (*~ Symbol B % |1 "’ﬂ%tﬁ o
® Sessions :

H Session Source : %E%”Use Custom Sessions”

B Sessions TimeZone : %E%"Local" C R TAddTE S s T Fé}ﬁﬂfﬁ[[, A4
B o 4 1 1 o

ICE.CHE.EURO_FX.200912 - Edit Symbol

Indexes | Settings | Sesions

Sessions Source

() Use Exchange & ECM's Sessions
(&0

O Use Custom Session Template

Sessions Details

Session TimeZone: | Local 7

Qpen Time Close Time Session End

ee [ =& [ =R |

(4) s et S AN

Symbol 4+ Description Exchange Listed  Category Daka Source Collect R:’\:
C #F Corn Futures CBT Futures eSignal Off
CL #F Crude Oil {Light) Futures MYME Futures eSignal Off
Laciale] CISCO SYSTEMS MASD Skocks Free Quates OFf
CT #F Cotton#2 Futures CEC Futures eSignal Off
ES #F S&P 500 E-mini Futures - Globex  CME Futures eSignal Off
FC #F Feeder Cattle Futures CME Futures eSignal Off
GC #F Gold Futures COMy Futures eSignal Off
elelale) GOOGLE TNC MASD Skocks Free Quates OFf
HO #F Heating Oil Futures MYME Futures eSignal
M e line S LIoleaded Fubur, LLYIE. Eubur) igoal
EICE.CME.EURO_FX.ZDDQIZ CME Indexes TOUCHANCE
e TRTEL CORE TIASD Trocks Free Guotes
10 #F Orange Juice Futures CEC Futures eSignal
% #F Japanese Yen Futures CME Futures eSignal
KC #F Coffee Futures CEC Futures eSignal
LE #F Lumber Futures CME Futures eSignal
LC #F Live Cattle Futures CME Futures eSignal
IH #F I aan Hane Fuboeac hE Fiihivar aSinnal =
£ >

5. suaY i HH Féfﬁ%ﬁ Quote Manager> Quote Manager F’ﬁflﬂ E\ﬂjf ¥ TOUCHANCE # igjo

15
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F%"“Tq‘—_' MultiCharts % b
1. ]%’t‘ﬁ'] ’ ﬁiﬁféﬁ;fi* gy
® TOUCHANCE = =% i i [[1 -

® MultiCharts Quote Manager EJHE%T B @F%tj; oo

2. ﬂfj?i,“ MultiCharts = #d =V o

3. W EH P 0 IR LR o f# "OKTE T MultiCharts = A
Oﬁ?f{ﬁ Online:Load the locally stored data and connect to a real-time data
feed

®ij Download missing historical data >/ > TOUCHANCE g} RN A
SR IEIV Y Tick w¥f] o

Data Server Hode

® Cnline: Load the locally skored data and
conneck ko a real-time data feed
Dovenload missing historical data

() Offline: Use only the locally stored data

Show Data Server Mode dialog box on skarkup

4. FriE - [##TAY Workspace > ﬁ%‘f[[f £! <j[J)%ﬁﬁﬂi”FiIe”%”New”%”Workspace”

16
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¥ MuttiCharts - Stocks Demo Workspace

File  Wiew Insert Format  Window  Help

= 4 Chart Window Ins @
B Cpen Workspace. . Chrl+0 Scanner Window Ckrl+Shift+Ins
@ 2 Close Workspace F4 QuokteManager Window
o PawerLan i
guage Editar

1 Save Workspace Chrl+S
g ;
0 Save Workspace As... Ctrl+shift+5 Sl workspace kM
8

Copy Image to Clipboard
L Send Imaage wia E-mail. ..

5. Frigf— #rpv Chart Window > "File”>”New”->"Chart Window”

J MuttiCharts - Untitled-2

File  Wiew Help

T 'I [F]  chart Window Ins I %
=5 Open Warkspace. ., Chrl+O Scannet Window Chrl+3hif+Ins
# Close Warkspace F4 QuoteiManager Window
= PowerLanguage Editor

Warkspace Chrl+h

6. F%{L_ Format Symbol : Symbol
®Data Source : ﬁjié% TOUCHANCE
®Symbol : ﬁ%&ﬁfﬂ_ Iéfl?;“itﬁﬁﬁﬂ Fﬁ#' Symbol
Format Symbol 7‘ 'z

Symbol | Settines | Stile | Sealing | Volume Profile

[ ] Merge Data Sources inta a Single Chart

Data Source: |TEILIEH!1'A.NEE [v] Higtary

o | o

All Syrnbols |Futures Stocks | Indexes | Forex | Cazh || Bonds Cc[*l’]

Symbol D ezcription
ICE.CME.EURO_Fx. 200312

7. 3 Format Symbol @ Symbol

-

17
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® Chart i+ = & [1 7 & & » = T Sessions F%tﬁ%%” Quote Manager #fl fj - #f

]%ti Default - i

®Data Range : ﬁ% Fii F%iu_ﬂ Day Back -

®Display :
H Time Zone': ﬁ%r%“tti Local »
Format Symbaol 7 E
Symhnl | Settings | Style Scaling | ¥Yohume Profils
Chart
Resolution: |1| | |Tick v|
(uate Field: | Trade w |
Sessiong: | Default b |
Build % olurne Or; | Trade Yolume b |
[rata Range
@® |80 | |payback [w||From 12/ 2/2009 v
O [12¢ 2/2009 ||| 112/ 2/2009 |||
Drizplay
Time Zane: | acal |
SubChart; Show On Top

8. 11 (- Format Symbol it i« G (R BB LA S E o oKL

18
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Wiew Insert  Format  Window  Help

BEE-BEa OAEEE @ HEG@EME- BEE

10. 1 P B " Insert” > Study” i #7F77 0 17

E.ELIR: 1 Tick

Indices Demo Workspace  Stocks Demo Workspace

ZH @ TOQO /4% %

| @2 & =200

I

B

J MultiCharts - Untitled-2 - [ICE.CME.EURG_FX.200912 - 1 Tick Bar

File ‘iew Insert Format  indow  Help

- G Symbal... F5 (@] [ | -

Study. .. CME ELRO_FX 2009

Drawing

19
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11 [irZ "Signal™f 35 - 2 5 2 MU pges o o fE el e

Insert Study 7 2
Indicator | Signals | Add-Ons

T Feady Statuz |
EntBar § Stop S5 ez

EntyBar ATR Stop L= ez

EntyBar ATR Stop S ez

EntyBar Pt Stop L ez

EntyBar Prit Stop 5 ez

Gap Down 5E ez

Gap UpLE ez

Inzide Bar LE Ves

Ihzide Bar SE Ves

K.eltner Channel LE Ves

K.eltner Channel SE Ves

K.ey Reverzal LE ez

K.ey Reverzal L+ ez

k.ey Reverzal SE ez

K.ey Reverzal 5 ez

MACD LE Tes
IMALCD SE Tes

b ormenturn LE Ves

M omenturm SE Ves

b ovedeg Cross LE ez

b ovdeg Crozs L ez

b owdeg Crozs SE ez

b ovedieg Crozs 5 ez

b ovdeg2Line Cross LE ez |
MovdeegZline Cross SE es ™|

Format
[ @= | [ E& |

12. 14l Format Object i fjfl » ¥ Close 5 1Y ﬁr'ﬁ;’% HI o

Format Objects ?

X

Symbols | Stodies || Drawings | Signals

MName Input String Statug Farmat...
MACD LE [12.28.9] an
MACD SE [12.26.9] an Remave

Statug
Add
Open Script

Optimize. ..

| Properties... |

20
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File Wiew Insert Format  Window Help

B-ER OEEE DE@EE- @ B o (ks @4 7

Indices Demo Workspace . Stocks Demo Workspace ', Untitled-2
el 2 ETOOZ4 % 2-2-2-@-@- Q068 7

0g/os 17153477

21
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F@“%—_’ MultiCharts FIE7 % b

Hi o o S I PR L R S RRE e Bl
1o ] R G

® TOUCHANCE = Hd =% i i [[1 -

O LT b IRUEE T b RIE 7

® MultiCharts Quote Manager [J ¥ % ft I:@”"&%‘L'F‘? °

® MultiCharts Chart Window mrlgﬁ;‘b Bl g ml o

2. %%’ Chart Window % F & “SA” i » 3 s F?Tgi%ﬁ*f ; ﬁ%ﬁ % Strategy
Properties...

Automate Order Execution

Skrategy Properties. ..

Settings: Inkeractive Brokers. .,

®Properties : f# ¥ & + < MUY - i 1A E

® Auto Trading : EIE*J B B,Lﬂlﬁéjgp%ig

®Backtesting : FE i pl ] frprgr%r%w&
Strategy Properties ? a

Properties | Anto Trading | Backiesting

Cogtz/Capitalization

issi @) per Trad
Comrigsion: $ |0 > per Trade
'f:J per Share/Contract

(®) per Trade

Sippage:  § |7 )
ippage: ¥ () per Share/Contract

22
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3. Auto Trading ﬁ'?f&?%’

Oﬁﬁﬁ,ﬁ?ﬁ?ﬂ%{ﬁ@ Require order confirmation E"\/iﬁ 2I3E .

®Select Broker Plug-inﬁ?%_f’ 2 TOUCHANCE: ## * "Settings”i& * % }b F@“’Eﬁ-‘? e
Strategy Properties 7 E

Froperties | Auto Trading | Backtesting

Automate Order Execution Settings
[ ] Require order confirmation [ ] Replace to Market Partially Filed Orders

Show order execution status
[ Awidio Alet

tMode Selection

(®) Entries/Exits are bazed on the execution confirmation by the broker [Sync]
() Entries/Exits are independent of the execution status at the broker [Aspnc)

Unfilled Strategy Order R eplacement

Azzign the Initial M arket Position at the Broker Settings

Select Broker Plug-in

TOUCHANCE v| | Seltings

[ ®e [ &

23
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Key to trading

4. TOUCHANCE % pb & &3
ow%ﬁ%:%ﬁﬁﬁﬁﬁ*ﬁww IR % - %L@Lum%gﬁfﬁo

T R B T Lookup 3 7 i B o ) % K iy
TR R mA ! g

O PR/ NI C PP HES [
Touchance Properties E
IRIRERTE BT
=iy Syrbal [D Symbal Hame Exc
SERIRTE | 000-0000901 benjamin001 =] (CE TWR I TR 201004 =504 (BEER) T
|CE. TwF FITX. 201005 =505 [&ERASTE) W]
JCE. TwF FITX. 201009 =509 (SEEIEIA) T
|CE. TwF FIT. 201006 =506 (SIEEEI ) T
S ICE. TWF FITX. 201012 FiG12 (BT W
it ICE. TWFFITR =i (EEHTE) W
T :ICE.TWF.FITX.2D1 004 ZEHE04 (5 EHAZTRR) Lookup
MREELR EERH
S @ EFAMRIHE HET  FaSHERS)
(O ROD
o O B K ARRAL ERER » #51REE) %] 3
CeEg#pETaErsmssE) [@TEaEtE
5. 7l fft 1 *ﬁMﬁ?ﬁ@wc’@%wwrﬁwb FRLEnge = f @t
(f FU%‘: bﬁiJA o(jér[—,\fl\%gﬁﬂj\q,%ﬂg%ﬁzm P J'EJJEF ‘FLLQJTLIE % TEH)

6. FIRAIHIFTT 0 PROC B T RS
MultiCharts ?“, ? FR N BB .

fﬁ’lﬁ M

Buy %fﬁ BiE
Sell = ‘ﬁﬁéﬂ e
Sellshort ig?ffﬁgﬂ oy
Buytocover a1 Tﬁfﬁiﬂé

ﬁﬁ’ﬁ;i& o
8. #%* Strategy Properties F%'{L_

P T OK S W [Tt ph

24
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# Chart Window L BEUSAT R E m}ﬂﬁﬁli%‘#&fggﬁ )

| Automate Order Execution

Strategy Propetties, ..

Settings: TOUCHAMNCE. ..

10. U FE R AL DBFIP e b -

By clicking '"es" you are agreeing to the following condiions:
Trade placement and execution may be delaved or fal due to market volatlity and volume,
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